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The Three Rules of Data Analysis 
Rules 1, 2, and 3: Make a picture. 
 
Pictures … 
 
1.  Reveal things that can’t be seen in a table of numbers.  
2.  Show important features and patterns in the data. 
3.  Provide an excellent means for reporting findings to others. 



Software for descriptive statistics 

•  You can use Minitab , Excel, SPSS or SAS to perform descriptive statistics 
analysis. 

   
•  Microsoft Excel has built-in options for data presentation and statistical 

analysis 

•  You may need to activate Excel’s Analysis Tool Pak Add-in to see these 
options 
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2.  Click Options shown 
in the drop down 
menu. This will open 
the Excel Options 
dialog box 

 

3.  Select Add-Ins in the 
left margin… 

 

How to activate excel data analysis tool pack 

1.  With Excel open, click 
on the File tab found 
in the upper left corner 
of your computer 
screen 
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4.  Click on Go at the 
bottom of the screen 

5.  Select the check 
boxes for Analysis 
ToolPak and Analysis 
ToolPak - VBA in the 
popup menu and click 
OK 

 

How to activate excel data analysis tool pack 
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6.  Select the 
Data tab. Click 
on Data 
Analysis on 
the right side 
of the 
application bar  
 
 
 
 

 

How to activate excel data analysis tool pack 
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Constructing a Frequency Distribution 

•  For quantitative data, Frequency distribution can be constructed that shows 
shows the number of data observations that fall into specific intervals 

 
•  Frequency distribution graphically summarizes information not readily 

observable by merely looking at data in a table 

•  It could be used for both discrete and continuous quantitative data. As you 
remember : 

 
•  Discrete data are values based on observations that can be counted and 

are typically represented by whole numbers 
–  represent something that has been counted 
–  take on whole numbers such as 0, 1, 2, 3 

•  Continuous data are values that can take on any real numbers, including 
numbers that contain decimal points 
–  usually measured rather than counted 
–  Examples are weight, time, and distance 



Constructing a Frequency Distribution 

•  Example:  Number of iPads sold per day 



Constructing a Frequency Distribution 

•  Example:  Frequency distribution of the number of iPads sold per day 



Relative Frequency Distributions 
•  Relative frequency distributions display the proportion of observations of 

each class relative to the total number of observations 
–  shows the fraction of observations in each class  
–  found by dividing each frequency by the total number of observations 
–  the fractions in a relative frequency distribution add up to 1.00 
 
•  Example : Frequency distribution of the number of iPads sold per day: 
  

Two iPads were sold on 28% of the days 



Cumulative Relative Frequency Distributions 

•  A cumulative relative frequency distribution totals the proportion of 
observations that are less than or equal to the class at which you are looking 

–  Shows the accumulated proportion as values vary from low to high 

•  Example :  

Three iPads or less were sold on 80% of the business days 



Using a Histogram to Graph a Frequency Distribution 

•  A histogram is a graph showing the number of observations in each 
class of a frequency distribution 

•  We usually use the term “bins” for the classes in the distribution 
 
 



Constructing a Histogram in Excel 

Step 1: Determine the number of groups or classes to use. 
 
Step 2: Establish the class width. 
 

 
 
 
Step 3: Determine the class range (bin range) for each class. 
 
 
Step 4: Count the number of values in each class using excel analysis 
tool pack :  

W =  Largest Value - Smallest Value
Number of Classes



Constructing a Histogram in Excel 

-  Select the Data tab, 
and click on Data 
Analysis in the 
upper right corner 

-  In the pop-up menu, 
select Histogram 
and click OK… 



Constructing a Histogram in Excel 

-  In the Input Range text 
box, highlight the 
desired data 

-  In the Bin Range text 
box, highlight the bin 
values (create bins if 
not already created 
before) 

-  For Output options, 
select New Worksheet 
Ply and Chart Output 

-  Click OK 



Constructing a Histogram in Excel 

-   Customize the Excel graph to make it more attractive 

-  Stretch size to better proportion 
-  Eliminate “more” bin 
-  Modify the graph and axis labels 
-  Remove the redundant “Frequency” legend 



Exercise: (constructing a histogram)  
 
Step 1: Open Capital.xls  
 
Step 2: 
Calculate Max and Min of data in B2:B301.  
Divide into 10 classes 
Class width =139. Lets use 150. 
 
Step 3: 
Using Min of 99 and class width of 150, we get class boundaries: 
90 – 249; 249 – 399; … 
Enter 249; 399;… in E2:E11 
 
Step 4: 
Tools/Data; Data Analysis; Histogram; Output range F1 
Highlight G2:G11; Column graph 
 

Constructing a Histogram in Excel 



•  For histogram in Minitab, Simply go to graph menu and select Histogram. 
 

Constructing a Histogram in Minitab 



•  Using the following command : 
 
/* Option group 5 (GRAPH SIZE) parameters. */ 
/*--Set Graph Size (in inches)--*/ 
ods graphics / reset width=6.4in height=4.8in imagemap; 
 
/*--SGPLOT proc statement--*/ 
proc sgplot data=SASHELP.CARS; 
    /*--Histogram settings--*/ 
    histogram Invoice /; 
 
    /*--Vertical or Response Axis--*/ 
    yaxis grid; 
run; 
  

 

Constructing a Histogram in SAS (Optional ) 



Histogram Properties 

①  It provides visual indication of where the approximate center of the data is. 
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Histogram Properties 

②  It provides visual indication of spread of data from the Center.  
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Histogram Properties 
③  We can observe the shape of the distribution 

Bimodal Histogram 

Skewed to the Left Skewed to the Right 



Rules for Classes for Grouped Data 

•  A histogram must satisfy these conditions. If it doesn’t we call it a “bar 
chart” 

1.  Equal-size classes. All classes in the frequency distribution must be of 
equal width 

2.  Mutually exclusive classes. Class boundaries cannot overlap 

3.  Include all data values. Make sure all data values are accounted for in 
the total row of the frequency distribution 

4.  Avoid empty classes. It is undesirable for a histogram to display a class 
so narrow that there are no observations in it 



The Consequences of Too Few or Too Many Classes 
•  Wide classes results in few class intervals 
 

–  Can obscure important patterns  
–  Gives a “blocky” distribution graph 
–  Summarizes the data too much 
–  Tells us little about the true distribution shape 

•  Example : 
    Bell Canada stock price change Sept 12 – Oct 21, 2011 
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The Consequences of Too Few or Too Many Classes 
•  Too many narrow classes in a histogram also has consequences 
 

–  Results in a “jagged” histogram 
–  Some classes may be empty 
–  Does not summarize the data enough 

•  Example : 
    Bell Canada stock price change Sept 12 – Oct 21, 2011 
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•  With good number of bins : 
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The Consequences of Too Few or Too Many Classes 



Histograms – Good Number of Bins  
Class Interval      Frequency 
20-under 30   6 
30-under 40   18 
40-under 50   11 
50-under 60   11 
60-under 70   3 
70-under 80   1 
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    Cumulative 
Class Interval   Frequency 
20-under 30   6 
30-under 40   24 
40-under 50   35 
50-under 60   46 
60-under 70   49 
70-under 80   50 
     



•  One method to determine the number of classes in a frequency distribution 
is the rule 

 
  
   
 where    k = Number of classes 
    n = Number of data points 

 
•  Find the lowest value of k that satisfies the rule  

•  Suppose  n = 50 
 25 = 32 < 50     (k = 5 is too small) 
 26 = 64 > 50     (k = 6 is a good choice)  

Number of Classes (bins) 

 2k > n



•  Once k is known, the width of each class can be found 

–  The width is the range of numbers to put into each class  

–  Round this estimate to a useful whole number that makes the 
frequency distribution more readable 

•  There is no one correct answer for the class width  

•  The goal is to create a histogram to clearly and usefully show the pattern in 
the data 

Number of Classes (bins) 

W =  Largest Value - Smallest Value
Number of Classes
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Stem and Leaf Diagrams 
•  A special table where each data value is split into a "leaf" (usually the last digit) 

and a "stem" (the other digits). 
 
•  The "stem" is used to group the scores and each "leaf" indicates the individual 

scores within each group. 

•  By listing all of the leaves to the right of each stem, we can graphically describe 
how the data are distributed. It provides a histogram-like view of the distribution. 

 



Stem and Leaf Diagrams 
Example :  
 
1.  Sort the data from lowest to highest 
2.  Determine the unique stem values 

 7, 8, 9 are the different stem values in this example 
3.  List the stems in a vertical column and then add the leaf values to the right of 

the appropriate stem, in ascending order 
 
 

 
   7 | 8  8  9  9  9  
   8 | 0  0  0  0  1  1  2  3  3  4  4  4  5  6  7  8 
   9 | 0  2  5 

 



Stem and Leaf Diagrams 
Example (continued ):  
 
•  To get more detail the stems can be split in half 
 

  7(5) | 8  8  9  9  9 
  8(0) | 0  0  0  0  1  1  2  3  3  4  4  4 
  8(5) | 5  6  7  8 
  9(0) | 0  2 
  9(5) | 5 

 
–  The stem labeled 7(5) stores all the scores between 75 and 79 
–  The stem 8(0) stores all the scores between 80 and 84 
 



Monthly Price Change in Enrons Stock 1997-2001 

•  All information is retained in a stem/leaf, whereas in a histogram, information 
is summarized 

 

Stem and Leaf Diagrams 



•  For steam and leaf plot in Minitab, Simply go to graph menu and select 
Steam and leaf. 

 

Constructing a stem and leaf diagram in Minitab 
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Frequency Tables 
•  Here Frequency table can also help to display qualitative data by indicating 

the number of occurrences of various categories 
 
•  A frequency table organizes data by recording totals and category names as 

in the table below. 

•  The names of the categories label each row in the frequency table. 

Province Corporate Stores 
Newfoundland and Labrador 13 
Prince Edward Island 4 
Nova Scotia 34 
New Brunswick 21 
Quebec 223 
Ontario 155 

Number of Loblaws Stores in Eastern Canada 



Relative Frequency Table 
A relative frequency table displays the percentages that lie in each 
category rather than the counts.  

Province Corporate Stores (%) 
Quebec 49.56 
Ontario 34.44 
Nova Scotia 7.56 
Other 8.44 
Total 100 

Percentage of Loblaws Stores in Eastern Canada 



Frequency tables in Excel 
 
•  Can use Excel’s COUNTIF function to count the number of values matching 

a category label 
 
•  FREQUENCY function can also help you to create a frequency table.  

•  Exercise :  

- Open Trucks.xls 
- To calculate how many trucks were observed in each month… 
- Enter months 1,…,12 in M2:M13 
- Select N2.N13 
- Use FREQUENCY function 
- Data: A2:A201; Bin: M2:M13;  
- Ctrl + Shift + Enter 

 



Frequency tables in Minitab 
 
•  For creating a frequency tables in Minitab, go to: 
 

   Stat . Tables . Tally Individual variables … 



Bar Charts 
A bar chart displays the distribution of a categorical variable, showing the 
counts for each category next to each other for easy comparison. 
 
The bar graph here gives a more accurate visual impression of the 
Loblaws data from pervious relative frequency table. 
 



Different types of Bar Charts 
  Horizontal bar chart   Vertical bar chart 

Can display multiple series with clustered bar charts or stacked bar charts: 



Bar Charts in Excel 
Exercise: 
 
Create a bar chart for frequency distribution that was calculated for Trucks.xls 
  



Bar Charts in Minitab 
•  For creating bar charts in Minitab, go to :  

    
    Graph . Bar Chart ... 



Bar Charts in SAS (Optional) 
•  Using the following code : 

/*--Set output size--*/ 
ods graphics / reset width=6.4in height=4.8in imagemap; 
 
/*--SGPLOT proc statement--*/ 
proc sgplot data=SASHELP.CARS noautolegend; 
    /*--Bar chart settings--*/ 
    vbar Make / transparency=0.00 dataskin=None name='Bar'; 
 
    /*--Category Axis--*/ 
    xaxis; 
 
    /*--Response Axis--*/ 
    yaxis grid; 
run; 



Histograms Vs. Bar Graphs. 
 
•  When do you use Bar chart and when Histogram ?    

Bar Graphs are good when your data is in categories (such as "Comedy", 
"Drama", etc). 
 
But when you have continuous data (such as a person's height) then use a 
Histogram. 
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Pie Charts 
•  Pie charts show the whole group of cases as a circle sliced into pieces with 

sizes proportional to the fraction of the whole in each category.  
 

•  Each segment of the pie represents the relative frequency of one category 

•  The Loblaws data is displayed below. 
 

Quebec, 
49.56 

Ontario, 
34.44 

Nova 
Scotia, 7.56 

Other, 8.44 

•  Use a pie chart to compare the relative sizes of all possible categories 



Donut Charts 

38% 

26% 

36% 
44% 

30% 

26% 

Sales by Region 

Europe 

Asia 

United States 

2005 2006 

Europe $12,704,714.00 $17,987,034.00 

Asia $8,774,099.00 $12,214,447.00 

United States $12,094,215.00 $10,873,099.00 



Pie Charts in Excel 
Constructing a Pie Chart in Excel 



Pie Charts in Excel 
Constructing a Pie Chart in Excel (continued) 
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Contingency Table 
•  Contingency tables provide a format to display observations that have more 

than one value associated with them 
 
•  Example : Survey question: “I have a strong preference for regional or 

traditional products and dishes from where I come from.” 

Count Marginal  
Distribution 



Contingency Table 
Continued  :  
 
-  To show how opinions on regional foods varied by countries, we can display 

the data in a contingency table.  

-  We have added introduced more detail by adding the countries as new 
variable. 

-  Each cell of a contingency table gives the count for a combination of values of 
both variables (e.g. Country, and Regional Preference). 

-  Here the indicated cell shows that 4 respondents from India (variable: Country) 
Don’t Know (variable: Regional Preference) how they feel. 

-  The marginal distribution of a variable in a contingency table is the total count 
that occurs when the value of that variable is held constant.  

-  Here the marginal distribution shows the number of respondents from China 
was 1502, from France was 1539,  



Contingency Table  
Example: Data was collected on the strength of consumer preferences for 
regional foods in their country. The data is displayed in both a frequency table and 
a pie chart. 



Relative Contingency Table 

Corresponds to the 
AND probability. 

•  We may display the data as a percentage – as a total percent, row percent, or 
column percent, which show percentages with respect to the total count, row 
count, or column count, respectively. 

 



Contingency Table - Conditional Distributions 
•  We may want to restrict variables in a distribution to show the distribution for just 

those cases that satisfy a specified condition. This is called a conditional 
distribution. 

 

•  Here we consider only the preferences of the respondents from India and the 
U.K. 

 



•  We may display the results of a 
conditional distribution as a pie 
chart or as a bar graph. 

 
•  The data from the previous table 

is displayed here as a side-by-
side bar chart. 

•  In a contingency table, when the 
distribution of one variable is the 
same for all categories of another 
variable, we say that the variables 
are independent. (That is, they are 
not associated.) 

•  If in a side-by-side bar chart, each 
pair of bars was the same height, 
then we can conclude the 
variables are independent. 

Contingency Tables - Bar Graph Side by Side Comparison 



Contingency Tables - Segmented (Stacked) Bar Chart 
•  Data can be displayed by dividing up bars rather circles.  A segmented bar 

chart divides a bar proportionally into segments corresponding to the 
percentage in each group. 

 

•  The data from the conditional distribution pertaining to India and the U.K. are 
displayed here as segmented bar charts. 



Constructing a Contingency Table in Excel 

1.  Click on any cell within your 
data 

2.  Choose the Insert tab 

3.  Click on the Pivot Table icon 

4.  Click on Pivot Table in the 
drop-down menu 

5.  A Create Pivot Table dialog 
box will appear. Click OK… 



Constructing a Contingency Table in Excel 

6.  A new worksheet 
will be created for 
your pivot table 

•  From the Pivot 
Table Field List, 

c. Drag the variable name to be 
summarized down into the 
Values box 

a & b. Drag the desired variable 
names down into the Column or 
Row Labels boxes, as desired 

a 
b 

c 



Constructing a Contingency Table in Excel 

Creating a Pivot Table in Excel (Final Result) 

•  Resulting pivot table: 



Constructing a Contingency Table in Excel 
Exercise :  
 
•  Open file high-desert.xls 

-  Click a cell within data 
-  Insert; Pivot table; ; existing worksheet 
-  Click and drag: 

-  Row: type;  
-  Column: region 
-  Data: sum of loan amount;  

-  Try a few other options 
 
•  Open file Capital.xls 

-  Click a cell within data 
-  Insert; Pivot table ; existing worksheet 
-  Row: credit card; Column: Gender 
-  Data: credit card  
-  To group rows in table, right click in column A; group;  
-   Click on “Sigma Values” “Value Field Settings” to get other options. 

 



Constructing a Contingency Table in Minitab 
•  For constructing contingency tables in Minitab, go to :  

  Stat . Tables . Cross Tabulations and Chi squares …  
 
 
 


